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SECTION 1

LOGGING IN

~~
emphasys

m Certification Portal = a—

Version: 7.0

il

NIFA

NEERASIA INVESTMENT FINANCE AUTICRITY®

*User Name:

*Password:

[JRemember me on this computer

> Forgot your user name?
> Forgot your password?
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New (Super) User
If you are a new user who will have full control (Super User) of the Certification Portal (CP), contact NIFA for a User ID
and Password.

New Non-Super User

If you are a new user assigned by the Super User, the Super User will set up your User ID, Password and assign
specific projects to you. Contact your Super User for log in credentials.

New super and non-super users will login using the NIFA temporary User ID and Password at the SYSTEM LOGIN
page.

P
emphasys

= Certification Portal = ——

Version: 7.0

NIFA

NEERASIA INVESTMENT FIVANCE AUTICRITY®

*User Name:

*Password:

[JRemember me on this computer

= Forgot your user name?
= Forgot your password?
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New users will be required to create a new User ID and Password.
NOTE: The username and password fields require at least 6 characters and are case sensitive.

@ & Test Management, LLC

ﬁ% Certification Portal

»
&

Change Your User Name & Password

Before you continue you are required to change your user name and password.

Please enter your current and new user names below.

*Current Login Name:[‘ ]

“New Login Name:

Please enter your current and new passwords below.
*Current Password:
“New Password:

*Confirm Password:

Once new credentials are created and logged in, user will be at the Landing Page (Snapshot).

%F Mﬁm' : i ‘]jt[‘ Projects On-Site Managers Q. Test Management,
= Certification Portal A »

»
i ¥

Snapshot

Projects Status & Search Annual Owner Certifications Submission Status
R Project ID:[| B 1 ot Submitted
H Projects .

1] Project Mame:
Grantee Number:
Status
" 1 Project

IDIS Activity Number:

Recently Viewed Projects

There are no itams to show in this view.
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EXISTING (COL) User Login

emphAasys
Eﬁﬂ Certification Portal

Version: 7.0

il

NIEA

NEERASIA INVESTNENT FIRANCE AUTRORITY*

“User Name:[l

“Password:
[J Remember me on this computer

=——=————m Lo

> Forgot your user name?
> Forgot your password?

Forgot User Name or Password

? . . Submit
> Forgotyour user namer Enter e-mail address and click

Please enter your email address in the box below.

o Recover Login Credentials
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> Forgot your password? Submit

Enter e-mail address and click

o Recover Login Credentials

Please enter your email address in the box below.

PLEASE NOTE: This feature is not currently active. At this time, please contact NIFA if you forget your username or
password.

End Section 1
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SECTION 2

ACCESSING PROJECTS
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Once logged into CP, the user will be on the LANDING PAGE (Snapshot) and can access projects using five different
options.

ﬁﬁ’ Certification Portal ‘ )  Projeets  Onsite Manager (@ A mestmanagement uc
a a8
Snapshot
Projects Status & Search Annual Owner Certifications Submission Status
| Project \D:D 1 Not Submiitted
Projects
% ! Project Name:
Grantee Number:
Status
« 1 Project

IDIS Activity Number:

Recently Viewed Projects

Q 1-1111 Test Project 3 Buildings

Projects Status & Search

A | - Project 1D:

H F'rc:je{:ts«
H - Project Name:

Grantee Number:
Status

¥ 1 Project DIS Activity Number:

= -

Option 1: Click on

Projects

Option 2: Click on Projects

Options 1 & 2 will take the user to this screen:

~
Eﬁ: kT, . @‘ Projects On-Site Managers ® 8 Test Management, LLC
Certification Portal
P

. & o
Projects
Showing 1 - 1 0f 1 records Import All Building Data Annual Owner Certification Proceed to Buildings

Annual Owner Certification
Project ID Project Name Buildings Contact Us
Status Last Submission Date

Q -1 Test Project Mot Submitted 3

ABC Street, LINCOLN, NE 68502
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Option 3: Enter Project ID and/or Project Name. Using this method requires the entries to be exact, i.e. spelling,
dashes, etc. Please note: Grantee Number and IDIS Activity Number are N/A for NIFA projects.

Project ID: «
Project Name: «

Grantee Mumber:

IDIS Activity Number:

Click on This option will take the user to this screen:

Q

~
emhasys _ . = )
ﬁﬁ’ Certification Portal {AY  Projects  OnSite Managers £ Test Management, LLC

»
3

Projects : ;
SimrTeT = Tak T s Import All Building Data Annual Owner Certification [ Proceed to Buildings [l

QResults for: Project ID: 1-1111 X %C\ear Al

Annual Qwner Certification
Project ID Project Name Buildings Contact Us
Status Last Submission Date

Q11 Test Project Mot Submitted
ABC Street, LINCOLN, NE 68502

Option 4: If you have recently viewed projects, a list appears of those projects Click on ’H next to desired project.
This option will take the user to this screen:

Recently Viewed Projects

-Q 1-1111  Test Project | 3 Buildings

jo]

s j -Sil &) = .
Eﬁﬁ Certification Portal )  Projects  OnSite Managers (®) A Testmanagement uc

»
b8

Generalimformation  Project: 1-1111 - Test Project » General Information

e A B kT Bt Address: ABC Street, LINCOLN, NE 68502

Annual Owner Certification ABC Street
. NE 68502 =

-

-

-

Buildings (3)

Electronic Documents Annual Owner Cert Buildings

i i
3

Not Submitted
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Projects
Option 5: Click on -

Eﬁl Certification Portal ‘

4

@ Projects On-Site Managers & Test Management, LLC

This will take the user to a list of projects that have been assigned to the user.

Qo

-
| emphasys _ -
o . Projects On-Site Managers Test Management, LLC
@ Certification Portal ‘ fy P & faal &
o
. A&
Projects — — —
Showing 1 - 1 of 1 records Import All Building Data Annual Owner Certification Proceed to Buildings
Annual Owner Certification
Project ID Project Name Buildings Contact Us
Status Last Submission Date
Q 1-nn Test Project Not Submitted 3

ABC Street, LINCOLN, NE 68502

End Section 2
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SECTION 3

MANUAL ENTRY
NEW MOVE IN
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Select the project the user will be working in. Click

~
emphasys _ : - o
Eﬁ’ Certification Portal ‘ el ot (3 2 mestmanagement uc

)

Projects — — -
Showing 1 - 1 of 1 records Import All Building Data Annual Owner Certification Bl Proceed to Buildings
Annual Owner Certification

Project ID Project Name Buildings Contact Us
Status Last Submission Date

Q 11 Test Project Mot Submitted 3
ABC Street, LINCOLN, NE 68502

Select the building the user is working in. Click on

~
emphasys _ - @ o
e . Projects On-Site Managers Test Management, LLC
Certification Portal ‘ n g 2 faa ®
. . oM A&
b GenerslInformtion Project: 1-1111 - Test Project » Buildings
» Import Al Building Data Address; ABC Street, LINCOLN, NE 68502
o A G Import Building Data | View Details | Change Report Period Submit Tenant Certs Proceed to Units
Buildings (3.
’ @ Placed In Service s
Building ID Date ast Report Date Current Reporting Period IRS Compliance Status HOME Compliance Status | Agency Compliance Status | Tenant Recert Status Submission Units
Date
Q NE-00-00001 01/11/2020 01/01/2020 - 12/31/2020 Not Tested Not Tested Not Tested Not Ready 4
Q NE-00-00002 02/15/2020 Not Tested Not Tested Not Tested Not Ready 2
Q NE-00-00003 01/28/2020 Not Tested Not Tested Not Tested Not Ready 4

Enter the Reporting Calendar Year the user is entering unit data for.

Update All Buildings H Save

To update the reporting year for all buildings in the project, check the box and click

~
emhasys . o
7 ‘ @ Projects On-Site Managers ® & Test Management, LLC

Certification Portal

»
¥

v cemetinfermzion —— Building ID: NE-00-00002 » Change Report Period

» Import Building Data Project: 1-1111 - Test Project

b Change Report Period “New Reporting Period: 01/01/2020 [F - 12/31/2020 [F -
»  Units

» Reports
Update All Buildings

Click on in the menu on left side of screen.

» General Information

» Import Building Data
» Change Report Period
» Units

» Reports
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For future unit entries if you have updated the reporting period for all buildings, you can get to the units by selecting

the building you want to work in and selecting

Eﬁl Ceil : @ Projects On-Site Managers Test Management, LLC
Certification Portal

-
L 2]

senerel Information Project: 1-1111 - Test Project » Buildings

Import All Building Data Address: ABC Street, LINCOLN, NE 68502

Buildings (3)

-

Proceed to Units

L. el

-

-

Placed In Service Last

Building ID Date Last Report Date Current Reporting Period IRS Compliance Status HOME Compliance Status | Agency Compliance Status | Tenant Recert Status Submission Units
Date
Q NE-00-00001 01/11/2020 01/01/2020 - 12/31/2020 Not Tested Not Tested Not Tested Not Ready 4
Q MNE-00-00002 02/15/2020 Not Tested Not Tested Not Tested Not Ready 2
Q NE-00-00003 01/28/2020 Not Tested Not Tested Not Tested Not Ready 4

Select the unit the user will be working in and click

am;-?é“‘.ps-_ . . . o . o -
ﬁﬁ] Certification Portal ‘ i el e £ Test Management, LLC

>
2]

v cenesimomavon— Building ID: NE-00-00002 » Units

Project: 1-1111 - Test Project

» Import Building Data
m Income & Rent Test New Tenant Cert Delete Tenant Certs Ready All Units
» Change Report Period
b Units Re-Certification Di
Unit 1D No. of Bedrooms Square Footage Status Head of Household SSN Ready to Submit Last Certification Date = IDI:E'M ue

» Reports

1 2 800 Vacant

2 2 800 Vacant

You must complete all applicable boxes on this page:

Eﬁ: E.;ﬂ ification Portal ‘ TAY  Projects  On-Site Managers g Test Management, LLC
General Informati it: : | Inf i & 8
» Generslmormation | Jnjt: 1, Tenant: VACANT » General Information
Bed SqFt System Designation  Report Period Building Project
2 800 Market Rate 01/01/2020 - 12/31/2020  NE-00-00002  1-1111 - Test Project

Head of Household Information

*Member Name: Social Security Number:
“Birth Date: B age Occupation: -
Sex v Marital Status: v
Ethnicity: v Race: N
Special Population: v Disabled: [
Household Data
*Move-In Date: = Househald Annual Income: $0.00 *Unit Assistance Type: v
*New Cert Date: E= Non Qualified Students: (] “Owner's Designation:  Market Rate A
Initial Certification: «* Family Size: 0 Restriction: A4
Ready to Submit: [J
Contact Information Transfer Information
Home Phone: - - Work Phone: - - Transferred From Building:
Email: Old Unit ID: Old Unit Move-In:
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Enter Member (HOH) name, Birth Date, Sex, Social Security Number, Occupation and Marital Status.
Ethnicity, Race, Specialy Population and Disabled are optional/non requried questions for the HOH to respond to.
(The questions are required to be on the application and the household may choose not to answer).

r~ Head of Household Information

*Member Name: || . Social Security Number:

*Birth Date: = Age: h Qccupation:
Sex: x h Marital Status:

Ethnicity: v Race:

Special Population: v Disabled:

=
" qm
"

Enter Move-in Date, New Cert Date, Unit Assistance Type, Owner’s Designation and Restriction. Check Non-Qualified
Student if household has students that do not meet any exceptions (HOME and/or LIHTC). Initial Certification will
automatically check for Initial Certification. Family size and Household Annual Income will auto fill when family data
is entered. Check box Ready to Submit when entry is complete. Note that with a new move in, Move in Date and

New Cert Date should be the same.

Move-In Date = 4
*‘Mew Cert Date e -

Initial Certification: «* Family Size:

Ready to Submit -

Household Annual Income: # *Unit Assistance Type
MNon Qualified Students: - # Owner's Designation: . LIHTC

# Restriction: 30750 (HOME - VL)

This information is optional in the system and not required by NIFA:

Contact Information 1

Home Phone Work Phone:

Email

This information will auto fill when a transfer occurs:

~ Transfer Information
Transferred From Building:

Old Unit 1D: Old Unit Move-In:

Click B=B&88 when done with the page or when ready to move to next unit.

When clicking a menu will open on left side of screen for entering additional household data.

» General Information
» Household Members
p Income

p Assets

p Unit Rent

Page 15



» Household Members

If more than one household member, click

members.

Unit: 1, Tenant: Jane Doe » Household Members

Bed SqFt System Designation Report Period Building Project
2 800 LowlIncome 01/01/2020 - 12/31/2020  NE-00-00002  1-1111 - Test Project
Member Name SSN Birth Date

to add all (adults, minors, unborn child, etc.) additional

oy
[ o

There are no household members to show in this view.

Family Size: 1

Minors: 0

Click New Member

New Household Member
Adding a new household member to the system.
[~ Household Member (Basic Data) —
*Member Name: Social Security Number:
*Birth Date; =] Age:

*Relation: r Occupation:

[~ Household Member {Demographics) -

Sex: v Marital Status:
Ethnicity: v Race:
Special Population: v Disabled:

Cancel

Enter Member Name, Birth Date, Relation, Social Security Number, Occupation.

New Household Member

Adding a new household member to the system.

I~ Household Member (Basic Data) —

|‘ Social Security Number;
Age:
" 4

*Member N.um-:|.

*Birth Date:

= -

*“Relation: Occupation:

Age Occupation
Full-Time Students: 0
T
v
v

=
.

Enter Sex and Marital Status. Ethnicity, Race, Specialty Population and Disabled are optional questions for all
members. (The questions are required to be on the application and the household may choose not to answer).

r Household Member (Demographics)

Sex: T - Marital Status:
Ethnicity: v Race:
Special Population: A Disabled:

.

L

Click BB when done with the page or to add additional members or when ready to move

to next unit.
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» Income

To add all household income, click on the menu on the left side of the screen.

a
o . & -
Unit: 1, Tenant: Jane Doe » Income
Bed SgFt System Designation  Report Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020 NE-00-00002  1-1111 - Test Project

m Blezz

' Member Name Source of Income Verification Annuzl Income

There are no incomes to show in this view.

Annual Income: $0.00

Annual Asset Income: $0.00 Total Annual Household Income: $0.00

Click B t0 enter household income by Member Name. All boxes with down arrows have drop down
selection. All fields must be completed.

New Income

Adding a new income to the system.

= Member Information -
"Member Name: v
Relation:
i~ Income Source & Amount -
Source of Income: v
Annual Income: Calculate
I Income Verification -
Verification Source: v
Verification Date: =

Member Information, click on down arrow to show a list of Member Names, select member name you are entering
information for.

Member Information

“Member Name:| Jane Doe Vl -

Relation: Head of Household

Income Source & Amount, click on down arrow to show Source of Incomes. Select type of income. Enter Annual
Income for the selected member or use the Calculate button as explained below.

Income Source & Amount

Source of Income:

Annual Income: $0.00

Page 17



User can click on calculate to have system calculate each earned income. Enter Pay Rate, Pay Frequency,
Hours per Year and the system will show you the Annual Income. For each income to calculate, user will need to click

@d8 The calculated incomes will populate the Annual Income box to the Income Source & Amount.

o Calculate Annual Income

$0.00

Income Verification, part of income process includes Verification Source and Verification Date.

Income Verification

Verification Source: v -
Verification Date: = -

Once all incomes have been entered and saved, the main tenant screen will show a calculated Annual Income.

a
.. . a a
Unit: 1, Tenant; Jane Doe » Income
Bed SqFt System Designation  Report Period Building Project
2 800  LowIncome 01/01/2020 - 12/31/2020  NE-00-00002  1-1111 - Test Project
=
O Member Name Source of Income Verification Annual Income
O  Jane Doe Wages 01/31/2020 - Employer Verification $31,200.00
Head of Household
Annual Income: $31,200.00 -
Annual Asset Income: $0.00 Total Annual Household Income: $31,200.00

Click B=&&88 when done with the page or to add additional incomes or when ready to move to
next unit.
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To add all household Assets (if any), click ‘E. on the menu on the left side of the screen.

. New Asset
Click on to enter household asset data by Member Name.

Unit: 1, Tenant: Jane Doe » Assets

&8
Bed SgFt System Designation Report Period Building Project
2 800 Lowlincome 01/01/2020 - 12/31/2020  NE-00-00002  1-1111 - Test Project
Member Name Type of Asset Verification Cash Value Annuzl Income

There are no assets to show in this view.
Annuzl Income: $31,200.00

Annual Asset Income: $0.00 Total Annual Household Income: $31,200.00

Fields with down arrows have drop down selections. All fields must be completed.

New Asset M

Adding a new asset to the system,

r Member Information

“Member Name: | Y

Helation

Asset Type & Value -
Type of Asset: ¥
*Cash Value:

Annual Asset Income:

I Asset Verification -
Verification Source v

Verification Date: m

In Member Information, click on down arrow to show a list of Member Names, select member name you are entering
information for.

Member Information

*Member Name: | Jane Doe Vl-

Relation: Head of Household

In Asset Type & Value, click on down arrow to show Type of Asset and select type. Enter Cash Value and Annual
Asset Income for the selected member.

[ Asset Type & Value

Type of Asset: L -
*Cash Value: $0.00 -
Annual Asset Income: -
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In Asset Verification, part of Asset Verification includes Verification Source and Verification Date.

Asset Verification -

Verification Source:

v
Verification Date: ™ -

=

Click B=S&88 when done with the page or to add additional Assets or when ready to move to

next unit.

»} Unit Rent

To enter rent data, click

Click BEIS¥ to access Rent fields.

on the menu on the left side of the screen.

a
o . . A a
Unit: 1, Tenant: Jane Doe » Unit Rent
Bed SgFt System Designation  Report Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020  NE-00-00002  1-1111 - Test Project
Rent Change Date:
Tenant Paid Rent: $0.00
Mandatory Charges: $0.00
Rental Subsidy: $0.00
Utility Allowance: $0 (Note: Please enter this amount only if paid by Tenant)
Gross Rent: $0.00 (Tenant Rent + Mandatory Charges + Utility Allowance)
. . A
Unit: 1, Tenant: Jane Doe » Unit Rent
Bed SqFt System Designation Report Period Building Project
2 800  Low Income 01/01/2020 - 12/31/2020  NE-00-00002  1-1111 - Test Project
Rent Change Date: =
Tenant Paid Rent: $500.00
Mandatory Charges: $0.00
Rental Subsidy: $0.00
Utility Allowance: $93  (Note: Please enter this amount only if paid by Tenant) -
Gross Rent: $5083 (Tenant Rent + Mandatory Charges + Utility Allowance)

Save & Close

When all data has been entered in all screens in the unit, click to return to Unit screen.
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Rent Change Date:

**DO NOT** enter a Rent Change Date except in cases where an increase or decrease occurred at a time other than
move-in or recertification that changes the tenant paid portion (TPP)., i.e. add new subsidy, remove subsidy, utility
allowance changes, etc.

Tenant Paid Rent:
This is the out of pocket amount the tenant pays (TPP) for rent.

Mandatory Charges: These are non-optional charges that the tenant must pay as a condition of occupancy (i.e.
garage rental, cable, etc....).

Rental Subsidy: This is the amount of subsidy the tenant is receiving in rental assistance (i.e. Section 8 voucher or
other government rental assistance).

Utility Allowance: This amount reflects what has been provided by the local PHA or a NIFA approved allowance.

Gross Rent:
Will include Tenant Paid Rent, Mandatory Charges, and Utility Allowance.
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Rent Changes at times other than move-in or recertification: From the Unit screen on the unit that the rent needs to

be changed for select

o
L 8

v censmnermzten — Building 1D: NE-00-00002 » Units

» Import Building Data Project: 1-1111 - Test Project

m Income & Rent Test New Tenant Cert Delete Tenant Certs Unit Transfer Ready All Units
Change Report Period

» Units

-

Unit 1D No. of Bedrooms Square Footage Status Head of Household SSN Ready to Submit Last Certification Date R&Csmg;i:on Er2
» Reports

Q 1 2 800 Occupied by Tenant Jane Doe ##%-22-0000 v 02/15/2020

t 2 2 800 Vacant v

Then select Unit Rent on the left tab

b General Information
b Household Members
p INncome
b Assels

} Unit Rent

Edit
Choose to access rent fields
. . A =
Unit: 1, Tenant: Jane Doe » Unit Rent s
Bed SqFt System Designation Report Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020  ME-00-00002  1-1111 - Test Project

Rent Change Date:

Tenant Paid Rent: $0.00

Mandatory Charges: $0.00

Rental Subsidy: $0.00
Utility Allowance: $0 (Note: Please enter this amount only if paid by Tenant)
Gross Rent: $0.00 (Tenant Rent + Mandatory Charges + Utility Allowance)
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Unit: 1, Tenant: Jane Doe » Unit Rent

Bed SqFt System Designation  Report Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020  NE-00-00002 1-1111 - Test Project
Rent Change Date: El -
Tenant Paid Rent: $500.00
Mandatory Charges: $0.00
Rental Subsidy: $0.00
Utility Allowance: 393 (Note: Please enter this amount only if paid by Tenant) -
Gross Rent: $593 (Tenant Rent + Mandatory Charges + Utility Allowance)

Save & Close
When all changes have been entered in the applicable fields, click to return to Unit screen.

End Section 3
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SECTION 4

MANUAL ENTRY
RECERTIFICATION
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Select the project and

EF emfhi Q
L - . Projects On-Site Managers Test Management, LLC
m Certification Portal ‘ m = g faa g
&
. & e
Projects
Annual Owner Certification
Project ID Project Name Buildings Contact Us
Status Last Submission Date
Q 1111 Test Project Not Submitted 3
ABC Street, LINCOLN, NE 68502
Select the building then click BESSSEEEAIS
. . oo A &
. General nfermatin Project: 1-1111 - Test Project » Buildings
» Import Al Building Data Address: ABC Street, LINCOLN, NE 68502
» Annual Owner Certification
» Buildings (3) Last
Building ID p‘E(EdD‘:;EM(e Last Report Date Current Reporting Period IRS Compliance Status HOME Compliance Status | Agency Compliance Status | Tenant Recert Status Submission Units
Date
Q NE-00-00001 011142020 01/01/2020 - 12/31/2020 Not Tested Not Tested Not Tested Not Ready 1
Q NE-00-00002 02/15/2020 01/01/2020 - 12/31/2020 Mot Tested Not Tested Not Tested Not Ready 2
Q NE-00-00003 01/28/2020 01/01/2020 - 12/31/2020 Not Tested Not Tested Not Tested Not Ready 4
Select the unit then click MRSRMEIEIESEE
e : a8
v cenensiiormzzen— Building 1D: NE-00-00001 » Units
} Import Building Data Project: 1-1111 - Test Project
» Change Report Period : :
y Units Re-Certification Dt
Unit ID No. of Bedrooms Square Footage Status Head of Househcld SSN Ready to Submit Last Certification Date € 'E;Ci' lon bue
b Reports ate
Q 1 2 800 : Occupied by Tenant Mary Jones 01/11/2020
2 1 650 : Vacant
3 1 650 Vacant
4 2 800 Vacant
Enter New Cert Date |~ =" """ ™ |and click M=EEE
v Genenintermation | Jnjt: 1, Tenant: Mary Jones » General Information
Bed SgFt System Designation  Report Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020  NE-00-00001  1-1111 - Test Project

Head of Household Information

*Member Name: Mary Jones social security Number:
“girth Date: 03/30/1973 [ Age 46 Occupation: ~
Sex: v Marital Status: v
Ethnicity: v Race: ~
Special Population: hd Disabled: (]

Household Data

Move-in Date: 01/11/2020 Househeld Annuzl Income: $0.00 “Unit Assistance Type:| No Assistance ¥
*New Cert Date: i) - Mon Qualified Students: [ *Owner's Designation:| LIHTC hd
Initial Certification: Family Size: 2 Restriction:  40% AMI v

Ready to Submit: [

Contact Information Transfer Information
Home Phone: - - Work Phone: - - Transferred From Building:
Email: Old Unit 1D: Old Unit Move-In:
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Click on member name if the household still has the same income so it can be edited:

A
. . . a e
v eeelinormation | Jnit: 1, Tenant: Mary Jones » Income
} Household Members Bed SgFt System Designation  Repoert Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020  NE-00-00001  1-1111 - Test Project
» Income
b Assets
» Unit Rent ] Member Name Source of Income Verification Annual Income
O Mary Jones Wages 01012020 - Employer Verification $25,000.00

Head of Household
Annual Income: $25,000.00

Annual Asset Income: $0.00 Total Annual Household Income: $25,000.00

Click and update the applicable fields.

Income » Mary Jones - Head of Household
/

Source of Income: Wages
Member Information

Member Name: Mary Jones

Relation: Head of Household

Income Source & Amount

Source of Income: Wages

Annual Income: $25,000.00

Income Verification

Verification Source: Employer Verification

Verification Date: 01/01/2020
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Income » Mary Jones - Head of Household

Source of Income: Wages
Member Information

Member Name: Mary Jones

Relation: Head of Household

Income Source & Amount

source of Income:  Wages v -

Annual Income: $25,000.00 -

Income Verification

Verification Source: Employer Verification hd -

Verification Date: 01/01/2020 [& -

Clck

Page 27




Mew Income

If the household has new income click

&
e . L)
b cealinomation— Unit: 1, Tenant: Mary Jones » Income
} Household Members Bed SqFt System Designation Repert Period Building Project
2 800  LowIncome 01/01/2020 - 12/31/2020  NE-00-00001  1-1111 - Test Project
b Income
b Assets
» Unit Rent ] Member Name Source of Income Verification Annual Income
O Mary Jones Wages 010172020 - Employer Verification $25,000.00

Head of Household
Annuzl Income: $25,000.00

Annual Asset Income: $0.00 Total Annual Househeld Income: $25,000.00

New Income

Adding a new income to the system,

Member Information

“Member Name:l hd

Relation:

Income Source & Amount

Source of Income: hd

Annual Income: Calculate

Income Verification

Verification Source: hd

Verification Date: E|

Enter all data and Click Save & Close

***Repeat income and asset edits and/or additional sources until complete.
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If a previous income is no longer valid check the box next to the member and the income that is no longer being

¥ Celete
received by the household and select

P
Fri . )
v seneclmemation it 1, Tenant: Jane Doe » Income
» Household Members Bed SgFt System Designation  Report Period Building Project

2 800 Low Income 01/01/2020 - 12/31/2020  NE-00-00002  1-1111 - Test Project
» Income

-
p Assets
»  Unit Rent Member Name Source of Income Verification Annual Income

Jane Doe ‘Wages 01/31/2020 - Employer Verification $31,200.00

Head of Household

Annual Income: $31,200.00

Annual Asset Income: $30.00 Total Annual Household Income: $31,230.00

X Delete 1 income selected

Income & Rent Test

» Household Members

Click
out during the year.

if there have been any changes to the members, i.e. member (other than HOH) moved

a
. . é& a
» ceneniiormaton —— Unit: 1, Tenant: Mary Jones » Household Members
» Household Members Bed SqFt System Designation  Report Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020  NE-00-00001  1-1111 - Test Project
» Income
p Assets
» Unit Rent O Member Name SSN Birth Date Age QOccupation
O UNBORN CHILD 2019
Unborn Child
Family Size: 2 Full-Time Students: 0
Minors: 0
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It is highly recommended the user view the Income & Rent Test. It will identify if the system determines Over
Income and/or Over Rent based on Certification date and Effective Income and Rent dates.

Unit ID: 1 » Household Income & Rent Limit Status

Project: 1-1111 - Test Project | Building: NE-00-00001

Household Information

Effective Maximum
Status
Unit 1D: 1 as of Amount
Income Limits 04/01/2020 $26,280.00 : Below Income Limit
Head of Household: Mary Jones -
Rent Limits 04/01/2020 $739.00 Below Rent Limit <

Family Size: 2
Mo. of Badrooms: 2
Household Income: $25,000.00

Gross Rent: $0.00

Upon reviewing all data entered in the system and the user determines an incorrect entry has been entered, other

Edit
than the Move In Date, select - (Move in dates can only be corrected by using Delete Tenant Cert).

) o . ] )
v seneriimormation it 1, Tenant: Mary Jones » General Information
} Household Members Bed SgFt System Designation Report Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020  NE-00-00001  1-1111 - Test Project
» Income B
[
p  Assets
B Head of Household Information
» Unit Rent
Member Name: Mary Jones Social Security Number:
Birth Date: 03/30/1973  Age: 47 Occupation:
Sex Marital Status:
Ethnicity: Race:
Special Population: Disabled:
. . . . Save Save & Close
Edit any correctable field identified below and select or
& e

-

ceneralmformation | njt: 1, Tenant: Mary Jones » General Information

Bed SgFt System Designation  Report Period Building Project
2

Household Members
800 Low Income 01/01/2020 - 12/31/2020  NE-00-00001  1-1111 - Test Project

-

Income

-

Head of Household Information

Assets
Unit Rent *Member Name: Mary Jones - Sacial Security Number: -

*Birth Date: 03/30/1973 Age: 47 Occupation: >

Sex Marital Status: v
Ethnicity: Race: -
- Disabled: [ -

-

-

Special Population:

Household Data

Move-in Date: 01/11/2020 Household Annual Income: $25,000.00 “Unit Assistance Type:  No Assistance A
Last Cert Date: 11/05/2020 Mon Qualified Students: [ *Owner's Designation:  LIHTC hd
Initial Certification: Family Size: 2 Restriction:  40% AMI hd

Ready to Submit.
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To print the Tenant Income Certification click Ibkaks Certification Form

» senentnformation | Jnyjt; 1, Tenant: Mary Jones » General Information

» Household Members

Bed SgFt System Designation Report Period Building Project
2 800 Low Income 01/01/2020 - 12/31/2020  NE-00-00001  1-1111 - Test Project

» Income - y
Edit Tenant Certification Form Income & Rent Test

b Assets

» UnitRent Head of Household Information
Member Name: Mary Jones
girth Date: 03/30/1973
Sex:

Ethnicity:

Special Population:

Household Data
Maove-In Date: 01/11/2020
Last Cert Date: 11/05/2020
Initial Certification:

Ready to Submit:

Contact Information
Home Phone:

Email:

Delete Tenant Certs

Social Security Number:

hge: 47 QOccupation:
Marital Status:

Race:

Disabled:

Household Annual Income: $25,000.00
Non Qualified Students:

Family Size: 2

Transfer Information

Work Phone: Transferred From Building:

©Old Unit ID:

Unit Assistance Type: No Assistance
Owner's Designation: LIHTC

Restriction: 40% AMI

Old Unit Mowve-In:

If a date of certification, move in or transfer was entered incorrectly, click Delete Tenant Certs to remove the

incorrect entry. Only the entry with

completed starting from top entry.

Unit ID: 1 » Tenant Certifications

Project: 1-1111 - Test Project | Building: NE-00-00001 @

Move/Transfer In

Head of Household Last Certification

Date Cate
01/11/2020 Mary Jones 11/05/2020
01/11/2020 Mary Jones 01/11/2020

Vacant
1 col.nifa.org says
Are you sure you want to delete the selected ltem?

End Section 4
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SECTION 5

MANUAL ENTRY
UNIT TRANSFER

1. Within Same Building (If project only has one building or when the project has multiple
buildings and the owner elected to treat the buildings as single buildings on the 8609)

2. Between Buildings (Multiple Building Project 8609 Election Only)
NOTE: Unit Transfers cannot occur on the same day. If the unit being transferred into

moved out the same day as the new transfer in, you will need to enter the day before as the
move out date.
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TRANSFER WITHIN SAME BUILDING

Select the project and click RASEEERCETICIITE

lficaiion F’ortal ‘ @ Projects On-Site Managers Test Management, LLC
. & e
Projects
Annual Owner Certification
Project ID Project Name Buildings Contact Us
Status Last Submission Date
Q 1-1111 Test Project Not Submitted 3
ABC Street, LINCOLN, NE 68502
Select the building and click RaflESSeREeVIE
2
. . . . . A &
Project: 1-1111 - Test Project » Buildings
Address: ABC Street, LINCOLN, NE 68502
Import Building Data View Details Change Report Period Submit Tenant Certs Proceed to Units H .
Placed In Service Last
Building ID Date Last Report Date Curmrent Reporting Period IRS Compliance Status HOME Compliance Status | Agency Compliance Status | Tenant Recert Status Submission Units
Date
Q NE-00-00001 01/11/2020 01/01/2020 - 12/31/2020 Not Tested Not Tested Not Tested Mot Ready 4
Q NE-00-00002 02/15/2020 01/01/2020 - 12/31/2020 Mot Tested Not Tested Not Tested Mot Ready 2
Q NE-00-00003 01/28/2020 01/01/2020 - 12/31/2020 Mot Tested Mot Tested Mot Tested Mot Ready 4
; ; ; ; Unit Transfer
Select the unit that is transferring OUT and click _
S
e i . A =
Building ID: NE-00-00002 » Units
Project: 1-1111 - Test Project
Unit ID No. of Bedrooms Square Footage Status Head of Household SSN Ready to Submit Last Certification Date Re-cam;;i;lon Br3
Q 1 2 800 Occupied by Tenant Jane Doe FEE-22-0000 02/15/2020
2 2 800 Vacant
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Unit ID: 1 » Unit Transfer

Project: 1-1111 - Test Project | Building: NE-00-00002

Unit Transfer Data

Current Unit: 1

Current Building: NE-00-00002

New Building ID: |[NE |- 00 - 00002

“Mew Unit:

*“Transfer Effective Date:

Tenant Paid Rent:
Mandatory Charges:
Rental Subsidy:
Utility Allowance:

GGross Rent:

Maximum Section 42 Rent:

Maximum HOME Rent:

Transfer Cancel

Click the down arrow in

v
i

$510.00
$0.00
$0.00
$93

$603.00

31,086.00

$644.00

to show available units |

the unit to transfer to. Once selected, complete all fields:

*Transfer Effective Date:
Tenant Paid Rent:
Mandatory Charges:
Rental Subsidy:

Utility Allowance:

Then click at the bottom of the page.
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TRANSFER BETWEEN BUILDINGS— Based on 8609 election when allowable.

Select the project and click on ibitace RGN

emphasys . @ Projects On-Site Managers Q Test Management, LLC
= Certification Portal faa}
2 A e
Projects
Annual Qwner Certification
Preject ID Project Name Buildings Contact Us
Status Last Submission Date
Q 1-11m Test Project Not Submitted 3
ABC Street, LINCOLN, NE 68502
Select the building and click BAEESZRCNTNIE
F~y
. . . . . A =,
Project: 1-1111 - Test Project » Buildings l
Address: ABC Street, LINCOLN, NE 68502
Placed In Service =t
Building ID Date Last Report Date Current Reporting Period IRS Compliance Status HOME Cempliance Status | Agency Compliance Status | Tenant Recert Status Submission Units
Date
Q NE-00-00001 01/11/2020 01/01/2020 - 12/31/2020 Mot Tested Mot Tested Mot Tested Mot Ready 4
Q ME-00-00002 02/15/2020 0170172020 - 12/31/2020 Not Tested Not Tested Not Tested Mot Ready 2
Q NE-00-00003 01/28/2020 01/01/2020 - 12/31/2020 Mot Tested Not Tested Mot Tested Not Ready 4
: : : : Unit Transfer
Select the unit that is transferring OUT and click _
A a8

Building ID: NE-00-00002 » Units l

Project: 1-1111 - Test Project

Bl Unit Definition Income & Rent Test New Tenant Cert Delete Tenant Certs : Bl Ready All Units :

Re-Certification Due

Unit ID No. of Bedrooms Sguare Footage Status Head of Household SSN Ready to Submit Last Certification Date it
Q 1 2 800 Occupied by Tenant Jane Doe FFE-£2-0000 02/15/2020
2 2 800 Vacant
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Unit ID: 1 » Unit Transfer

Project: 1-1111 - Test Project | Building: NE-00-00002
Unit Transfer Data

Current Unit: 1
Current Building: NE-00-00002

New Building ID: [INE |- 00 - 00002

“New Unit: b
“Transfer Effective Date: =
Tenant Pzid Rent: £510.00
Mandatory Charges: £0.00
Rental Subsidy: £0.00

Utility Allowance: £93

Gross Rent: $603.00

Maximum Section 42 Rent: 51.066.00
Maximum HOME Rent: $644.00

New Building ID: [NE |- 00 - 00002

Click the next to to select the building they are
transferring to.

¥

Click the down arrow in to show available units ¢ " and select
the unit to transfer to. Once selected, complete all fields

*Transfer Effective Date: E

Tenant Paid Rent; -

Mandatory Charges: -
Rental Subsidy: -

Utility Allowance: -

then click BIGIEEN at the bottom of the page.

*New Unit: v

END SECTION 5
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SECTION 6

MANUAL ENTRY
MOVE OUT
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Select the project and click BESESERCRTICIYEE

®m Certification Portal ‘ (AY  ojecs  Omsite Monagers @

Projects
Annual Owner Certification

Project ID Project Name Buildings
Status Last Submission Date

Q 11111 Test Project Net Submitted 2
ABC Street, LINCOLN, NE 68502

Q no-18 WINTER SOLSTICE Not Submitted 01/19/2018 2 @
754 leicle Way, SPIRIT LAKE. 1A 513600000

Select the building and click
Project: 1-1111 - Test Project » Buildings

Address: ABC Street, LINCOLN, NE 68502

Import Building Data View Details Change Report Peniod Submit Tenant Certs Proceed to Units i

Placed In Service

Building ID Date Last Report Date Curmrent Reporting Period IRS Compliance Status HOME Compliance Status | Agency Compliance Status | Tenant Recert Status
Q MNE-00-00001 0171172020 01/01/2020 - 12/31/2020 Not Tested Not Tested Not Tested Mot Ready
Q NE-00-00002 02/15/2020 01/01/2020 - 12/31/2020 Not Tested Not Tested Not Tested Not Ready
Q NE-00-00003 01/28/2020 01/01/2020 - 12/31/2020 Mot Tested Not Tested Mot Tested Mot Ready

Select the unit and click
Building ID: NE-00-00002 » Units l

Project: 1-1111 - Test Project

m @l Unit Definition Income & Rent Test New Tenant Cert Delete Tenant Certs [ Unit Transfer | Ready All Units i

Unit ID No. of Bedrooms Square Footage Status Head of Household 55N Ready to Submit Last Certification Date
Q 1 2 800 : Occupied by Tenant Jane Doe #EE-#£-0000 02/15/2020
2 2 800 | Vacant

Enter " Date:m ™ then click at the bottom of the page.
Unit ID: 1 » Unit Move Out

Project: 1-1111 - Test Project | Building: NE-00-00002

Building ID: NE-00-00002
Unit D21

Head of Household: Jane Doe

“Move Qut Date: i -

(U Eviction

Feason for Eviction:

End Section 6
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SECTION 7

3R PARTY SOFTWARE
TENANT DATA UPLOAD

1. All Buildings — One File
2. Single Buildings — Multiple Files (based on number of buildings in project)
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UPLOADING ALL BUILDING XML FILE
If the 3 party software (i.e. Yardi, RealPage, etc.) creates an XML file that includes all buildings in the project,

highlight the project and click

amp?s-;.s‘ ) ' . - O as
Eﬁﬂ Certification Portal ‘ (Y Projects  On-Site Managers £ Test Management, LLC

>
L ]

Projects

Showing 1 - 1 of 1 records Import All Building Data Annual Owner Certification [l Proceed to Buildings [

Annual Qwner Certification
Project ID Project Name Buildings Contact Us

Status Last Submission Date

Q 1111 Test Project Not Submitted H
ABC Strect, LINCOLN, NE 68502

» ceneaimformztion —— Building 1D: NE-00-00002 » Upload Data

) Impoert Building Data Project: 1-1111 - Test Project

B “Please Browse to Select the Document:l Choose File | No file chosen ] -
p  Units
» Reports

l ] Overwrite existing Unit Activity

. . ‘ Choose File No file chosen ‘
Click on Choose File

Select the XML file created by the 3™ party software (typically found on the C: drive), click E and click

Upload Document
to complete the process.

e o x
)] « [l » ThisPC » Music v | [ Seachm e
Organize = New falder = I -]
| b & This PC Mame Date modified
< 4l Network

< w > |
File name: w | (Al FI b

Documents can be uploaded multiple times for the same project as needed, due to errors. After the initial upload,

any subsequent uploads, you must check the box | 2verrte existing Unit Activity

NOTE: If user is unable to locate file on the computer, do a search for .xml and it should show up.
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UPLOADING SINGLE BUILDING(S) — Even when multiple buildings in the project.

If the third-party software makes a separate XML file for each building in the project, you will need to go to the
Building Screen to upload each of these files.

Proceed to Buildi
Highlight the project and click

~
eminasys _ . @ 0
S : Projects On-Site Managers Test Management, LLC
ﬁg’ Certification Portal ‘ 0} 2 g faa &
rY

: & -
Projects ; ;
Showing 1 - 1 of 1 records Import All Building Data Annual Owner Certification H Proceed to Buildings :

Annual Qwner Certification
Project ID Project Name Buildings Contact Us
Status Last Submission Date

Q 11111 Test Project Not Submitted H
ABC Street, LINCOLN, NE 68502

Select the building that matches the XML file and click

~
emphasys 5 + @ Q
S : Projects On-Site Managers Test Management, LLC
Eﬁ’ Certification Portal ‘ 0} 2 g faa &
rY

: & -
Projects ; ;
Showing 1 - 1 of 1 records Import All Building Data Annual Owner Certification Hl Proceed to Buildings :

Annual Qwner Certification
Project ID Project Name 8uildings Contact Us
Status Last Submission Date

Q 1111 Test Project Not Submitted H
ABC Strect, LINCOLN, NE 68502

*Please Browse to Select the Document;| Choose File |No file chosen

» cenealimomation —— Byilding 1D: NE-00-00002 » Upload Data

b Import Building Data Project: 1-1111 - Test Project

e “Please Browse to Select the Document:l Choose File | No file chosen I -

p Units

» Reports
[J Overwrite existing Unit Activity

# Upload Document Cancel

Select the XML file and click —_“**" | and then click at the bottom of the Upload screen to complete
the process. This must be done for all buildings.

) = B[ » ThisPC + Music v o

Organize »  New Folder - | @
© i This PC Name Date modified
4 & Network
'
< w >
File narme: ~ | |All Files ~
Open iv | Cancel |
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Continue this process until all buildings have been uploaded.

NOTE: If user is unable to locate the .xml file on their computer, do a search for .xml and it should show up.

Building ID: NE-00-00002 » Units l

Project: 1-1111 - Test Project

m Unit Definition Income & Rent Test New Tenant Cert Delete Tenant Certs Unit Transfer Ready All Units

o . P d to Units . Ready All Units .
Go back to BEEESRCEIIEIEEN and click and click on Y for each building.

Documents can be uploaded multiple times for the same project as needed, due to errors. After the initial upload,

any subsequent uploads, you must check the box ‘ Overwrite existing Unit Activity

If you upload an incorrect BIN or Project xml file that does not belong to the selected project, this message will
appear:

0 Invalid File - Process Aborted!

Found transaction record(s) for an existing Project
different than Project currently selected.

When an XML file has errors during import, the process will cancel and provide an Error Log, see below. If you
receive errors, provide a copy of the Error Log and XML file via e-mail (txcr.multifamily@nifa.org) to the NIFA tax
credit department for review, correction and re-uploading.

Cancel . g
Locate the correct xml file to upload or select " and program will return to the Building screen.

Delete Tenant Certs

If a date of certification, move in or transfer was entered incorrectly, click Delete Tenant Certs to remove the

incorrect entry. Only the entry with X can be deleted. When more than one entry has a X delete must be
completed starting from top entry.

137.117.99.11 says

Are you sure you want to delete the selected Item?
|

1 “ cancel

= 1

END SECTION 7
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SECTION 8

ANNUAL CERTIFICATION
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Annual Owner Certification

The system requires it to be submitted in order to submit the building(s).

» General Information
» Import All Building Data
»  Annual Owner Certification

p Buildings (3)

Project: 1-1111 - Test Project » General Information

Address Type of Certification
ABC Street, LINCOLM, NE 68502  Certification Correction

*Mew Certification
Period: B - il

O Mo Buildings have been Flaced in Service
) At least one building has been Placed in Service but owner elects to begin credit period in the following year
® Mone of the above applies

The Undersigned:

On Behalf of:

1. The project meets the minimum requirements of: (check one)

® 20-50 test under Section A2(g)(1)(A) of the Code
(0 40-60 test under Section 42(g)(1)(B) of the Code (25-60 NY Only)
(0 15-40 test for "deep rent-skewed” projects under Section 42(g)(4) and 142 (d)(4)(B) of the Code

2. There has been no change in the applicable fraction (as defined in Section 42(c)(1)(B) of the Code) for any building in the project:

® No Cha nge OChange

Save & Close Submit Certification Annual Owner Certification Form

Annual Owner Certification Form

Prior to submission if you would like to print the form select . The form will open
in a separate window for you to print.

End Section 8
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SECTION 9

REVIEWING DATA AND SUBMITTING TO NIFA

Page 45



REVIEWING UNIT DATA AND READYING UNITS FOR SUBMISSION.

v ceneimomaton— Building 1D: NE-00-00002 » Reports
Import Building Data project: 1-1111 - Test Project

o
L L

3
Change Report Period " LIHTC/HOME Annual O
4 ange Report Feno nnual Beeapancy ~ Oshow only last 4 digits of S5N in reports
O include units without recent activity
b Units [ Run Report for all Buildings
} Reports Household Income & Rent Limits Status

These reports can also be downloaded to Word or Excel.

LIHTC/HOME Annual Occupancy

¥} Include units without recent activity

¥ Show only last 4 digits of SSN in reports

Run Report for all Buildings

Detail Report @ I I

STUDENT EXPLANATION

1 - TNAF assistance. Generated on 12/2/2020 by Test Management, LLC  Page 1of 1
Nebraska Investment Finance Authority 2 - Job Training Program.
3 - Single parent/dependent child.
LIHTC/HOME Annual Occupancy Report 4- Merriedointrewrn
5 - Previous Foster Care.
6 - Extended-Use Period.
Effective . Age #in | Non- | Qual
Rent Initial G A | Monithl Al it of Mrkt
Unit a Move-in | Move-Out Head of Head of Date/Last e i 1055 Annus onthly RHS Rent Mandatory mount o Hshid | qual | Stdnt "
Unit 5q Ft BR Change Cert Income at Tenant Paid Rental util Allow Unit
ID Date Date Household SSN | Household Name | Certification Date YN of Recert Rent Overage Charges Subsid at Stdnt | Expin /N
Date Hshid Y Recrt | /N | Code
Project: 1-1111 Test Project, Project Address: ABC Street
Building: NE-00-00002, Total Number of Units: 2
1 800 2 02/15/2020 ##£-#%-0000 Jane Doe 02/15/2020 11/02/2020 Y 29 $31,230.00 $510.00 £0.00 50.00 50.00 $93.00 1 N N

Household Income & Rent Limits Status

Detail Report @ ! !

Nebraska Investment Finance Authority Generated on 12/2/2020 by Test Management, LLC ~ Page 1of 1

Household Income & Rent Limits Status Report

; Last LastRent | Total Annual
| U B.Ed Head of Househeld Full Mame Hous_ehold LGl Certification | Change Household | Income Limit Eizzne Income Limit Status MELily Rent Limit Elieche Rent Limit Status
L] Size Size Date Date Gross Rent Date
Date Date Income
[
Project: 1-1111 Test Project, Project Address: ABC Street
H Building: NE-00-00002, County: LANCASTER
‘ 1 2 Jane Doe 1 02/15/2020 02/15/2020 11/02/2020 $31,230.00 $33780 04/24/2019 Below Income Limit $603.00 $1,086 04/24/2019 Below Rent Limit

There are 2 ways to make a unit Ready to Submit.

At the BUILDING Level Screen:

Click this allows the building to be submitted to the agency. When using 3™ party uploads, this is the
preferred method to ready the units. Manual entries can also use this process by waiting until they have entered all
unit data for the building(s).

» cesaoman— Building 1D: NE-00-00002 » Units o

» Import Building Data Project: 1-1111 - Test Project

Unit Definition | Income & Rent Test New Tenant Cert | Delete Tenant Certs [l Unit Transfer [l Ready All Units [ H
» Change Repart Period
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Ready to Ready to

Submit Submit
v
v
v
v
v
v
v

To manually check the | e/ tosubmt while in each unit entering data the user can check the box Ready to

Submit within the Unit screen.

Unit: 1, Tenant: Jane Doe » General Information
Bed SqFt System Designation  Report Period Building Project
2 800  Low Income 01/01/2020 - 12/31/2020  NE-00-00002  1-1111 - Test Project

Head of Household Information

“Member Name: Jane Doe Social Security Number: 000-00-0000
*Birth Date: 03/30/1990 E Age: 29 Qccupation:  Business/Office A
Sex Female A Marital Status:  Single h
Ethnicity: ~ Race: ~
Special Population: v Disabled: [J

Household Data

*Move-In Date: 02/15/2020 E| Household Annuzl Income: $31,230.00 “Unit Assistance Type:  No Assistance hd
Last Cert Date: 02/15/2020 Non Qualified Students: [ “Owner's Designation:  LIHTC v
Initial Certification: « Family Size: 1 Restriction: 60% AMI hd
Ready to Submit: [ —
Contact Information Transfer Information
Home Phone: - - Work Phone: - - Transferred From Building:
Email: Old Unit 1D Old Unit Move-In:

Save & Close

END SECTION 9
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SECTION 10

MANAGEMENT CONTROLS
(SUPER USER)
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On-Site Managers

Manage On-Site Managers

£R

} Manage On-Site Managers On_Site Ma nagers

= I OO0

O Full Name Login Name Email Financial Manager Only

Certification Portal @‘ Projects On-Site Managers ® 8 Test Management, LLC

o
[ 1

Bab Builder bobbuilder bob@gmail.com

New

New On-Site Manager

Adding a new on-site manager to the system.

USER NAME MUST BE AT LEAST SIX CHARACTERS

— General Information

“First Name: | ‘

Middle Name:
“Last Name:
*Email:

Financial Manager Only: [

~ Login Information

*User Name:

*Password:
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Reset Password

@ Emphasys Certification Portal - On-Site Manager Configuration - Google Chrome

Ll

8 colnifa.org/OnSiteManagerConfig.aspx?pageDatakey=342

[y
h

On-Site Manager » Bob Builder

Existing on-site manager configuration.

Reset Password Unlock Projects

— General Information

First Mame: Bob
Middle Mame:
Last MName: Builder
Emazil: bob@gmail.com

Financial Manager Cnly:

— Login Information

User Name: bobbuilder

Password: snowing

col.nifa.org says

Are you sure you want to reset this on-site manager's password?

- N -
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Unlock Projects

B Emphasys Certification Portal - On-5Site Manager Configuration - Go

col.nifa.org/OnSiteManagerConfig.aspx?pageDataKey=
& colnif /OnSiteM Confi ? DataKey=342

- On-Site Manager » Bob Builder g, : : :
Existing on-site manager configuration. 5 5

e General Information
First Name: Bob
Middle Name:
Last Name: Builder
Email: bob@gmail.com

Financial Manager Only:

Login Infarmaticn

User Name: bobbuilder

Password: snowing

col.nifa.org says

Are you sure you want to unlock all projects for this on-site manager?

- KB
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Project Assignment

Choose from drop down list

o]

. . Projects On-Site Managers Test Management, LLC
fication Portal L = A g

]

» wensgeonsie vanges QN -Site Manager Project Assignment

» Project Assignment
Select On-Site Manager For Project Assignment

| ] 4

Project Assignment

Project 1D Project Name Assigned On-Site Managers

1111 Test Project —UNASSIGNED--
ABC Street, LINCOLN, NE 68502

End Section 10
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